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Introduction to ArcGIS 10 

 

 

1. Download data from NCDOT GIS site 

 Rd_Char_Mlpst 

 Countyboundaries 

 Bridge locations 

 Topo map 

 

2. Launch ArcMap 

 Introduce interface 

 

Open                                                                                                                        Tool box 

      Save                                                                                                  Catalog  Search 

              Print         Paste     Undo                                 Table of Contents 

                     Copy                        Add Data                      Editor 

 
 

                             Fixed Zoom out                                                  Display XY 

                         Fixed Zoom in                                                Find 

                   Full Extent        Select Features             Measure 

              Pan                                                  Identify 

        Zoom out                                   Select Elements 

Zoom in     Previous View 

 

 

 

3. Symbolization 

 Add NCDOT Divisions of County Boundary 

 Right click CountyBoundary in Table of Contents (TOC) 

 From Layer Properties select Symbology tab 

 Select Categories from Show list 

 Unique Values is the default 

 Select Dot_Divisi from Value Field drop down list 
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 Click Add All Values 

 Click OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Labels 

 To turn on labels for county names, 

 Right click on layer, check beside Labels 

 To change the field displaying Labels, right click on layer you want to label > 

select Properties > Labels 

 Select the field to label from the Label Field Drop down 

 
 

 Label Rd_Char_Mlpst by Street Name field, and by type 
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5. Converting Labels to Annotation 

 

 Right click the Countyboundary layer, click labels 

 Click Customize, point to toolbars, click Labeling 

 Click the View Unplaced Labels button 

 Unplaced labels appear in red. Click View Unplaced 

Labels button again to hide unplaced label 

 Type 3,000,000 in Map Scale box & press Enter 

 Right click Layers, point to 

Reference Scale, then click Set 

Reference Scale 

 In the Table of Contents, right 

click Layers and click Convert 

Labels to Annotation 

 Uncheck the Feature Linked 

column 

 Navigate to GDB under 

Annotation Feature class 

 Check the box for Convert 

unplaced labels to unplaced 

annotation 

 Click Convert 

     

  

 

 

 

6. Select by Attribute 

 Division 

 Click Selection, Select by Attributes 

 Add the Layer to Select from 

 Double click the field to select 

from as the first part of your  

           expression 

 Select Operator 

 Get Unique Values 

 Verify equation   

 Click OK   
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7. Export data, create new layer 

 Right Click layer with selected 

attributes 

 Slide down to Data 

 Click Export Data 

 Select Selected Features 

 Select this layer’s source data 

 Navigate to path where data is stored 

 Click OK 

 Add feature class to map as a layer 

 

TIP – Be aware if you are using shapefiles vs 

geodatabase here. The process for saving is 

slightly different. 

 

 

 

 

 

 

 

8. Overlay Rd_Char file on new Division layer 

 Select by location to see results 

 Click Geoprocessing 

 Click Clip 

 Select Input Feature (or drag and drop layer from Table 

of Contents) 

 Select Clip Feature 

 Navigate to path to save layer  and name layer 

 Click OK   
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9. Create a Route by Selection 

 Use ID tool to locate 2 routes  

 Right click layer and make it the only selectable layer 

 Click Selection tab 

 Select by Attributes 

 Add Layer to choose selection from 

 Method , Create a new selection 

  Select field, operator and value to write expression 

  Click OK 

 Click Selection 

 Click Select by Attributes 

 Verify Layer 

 Change Method to Add to current selection 

 Add new route number to expression 

 Click OK 

  Export data as new layer with meaningful name,           

ie Route 1 

 

10. Add a buffer 

 Buffer Route 1 

 Right click layer and make it the only selectable layer 

 Click Geoprocessing tab 

 Input feature to buffer 

 Input linear measurement and units 

 Select Dissolve type 

 Click OK 

 Clear selection   

 Symbolize buffer 

 

 

11. Launch ArcCatalog to add WMS 

 Click on Tools, Options, and check the box beside GIS Servers 

• To add the 2010 orthoimagery Web Map Service open Internet Explorer 

• In the google search window, type “NCOne Map wms” 

• Click the following option from Internet search: 

               
• Click  NC OneMap web service catalog 
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• Open ArcCatalog  

• Click GIS Servers 

• Click Add WMS Server 

• Paste URL of WMS into URL 

box 

• Select Get Layers 

• Select 2010_Orthimagery under 

the 2010_Orthoimgery directory 

• Click OK 

• To check connection, right click 

on ArcGIS service in ArcCatalog 

and refresh 
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To add the imagery and data to the Table of Contents in ArcMap, 

 

• Click Add Data icon and navigate to ArcCatalog  

• Select GIS Servers 

• Select 2010 orthoimagery on imagery.nconemap.com 

• Select 2010_orthoimagery 

• If the Geographic Coordinate Systems Warning Dialog opens, read it, select   

GCS _North_American_1983 option, then close the dialog window 

  

 

 

 

 

12. Add Bing Maps 

To add the Bing Maps services into your current ArcMap 

map document, click File > Add Data > Add Basemap 

and double-click the service you want to add. The service 

will be added to your map inside a basemap layer to 

provide you with the best performance. Bing Maps 

services are free for ArcGIS Desktop users. 

 

 

 

13. Bring in Excel Spreadsheet 

 Examine fields for Lat/Long fields 

 Import coordinate system 

 Display XY Data 

Add Excel worksheet from Add icon     to convert to 

shapefile or geodatabase feature class 
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 Open Spread sheet in Excel     

 Examine data for longitude and latitude fields  

 Add Lat/Long columns (if necessary) – Be sure to use a negative sign in 

Longitude column 

 Format Cells as Number with as many decimal places as needed 

 Save file and close it 

 

 

 

 

 To convert the file, launch ArcMap 

  Select Add Data icon and navigate to 

work folder 

 Select Crossing excel data file, add 

  Right Click Excel$ click Display XY 

Data 

 Display XY Data Dialogue Box opens 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  The file should be in the dialog box 

 Specify the fields for x, y coordinates 

 X field should be longitude, and Y field should 

be latitude 

 To change the coordinate system from Unknown, 

click Edit 

  

  When the Spatial Reference Properties dialog 

box opens, click select 

 Browse for the Geographic Coordinate System, 

select World folder, then browse for WGS 1984 

projection from the list and click Add. 
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TIPS – Check the layer properties of data in your .mxd. Click the Source tab and look at 

the Projected Coordinate System and the Geographic Coordinate System. This will 

provide you with the coordinate system information you need to use. 

 You will receive message that Table Does 

Not Have Object-ID Field message. 

 Click OK – this lets you know you need to 

export the file to create a Shapefile. 

 The temporary file should be visible as a 

layer in ArcMap. 

  

 

 

 

 

 

 

 

 

Create the Final Shapefile 

 Right click the event layer and navigate down the 

pop-up menu to Data > Export Data  

 In the Export Data dialog, this layer’s source data and 

browse to the directory where you want to store this 

layer. 

 Click Ok, and Add exported data to map as a layer  

      

 

 

 

 

14. Editing 

                                                                                                                                                                                                                                       

 METHODS 

 

CREATE SHAPEFILE        

 Right on file location in ArcCatalog 

 Slide to New 

 Click Shapefile 

 Name new shapefile and select geometry 

 Select or import coordinate system 

 Click OK 
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CREATE NEW POINT                                                                           Editor Tool 

 Turn Editor ON click Editor icon or 

right click the layer, slide to Edit 

Features, click Start editing 

 Click Editor drop down menu and 

make sure Start Editing is selected 

 If error menu pops up, read the 

message and check your data. Perform 

necessary edits, transformation 

  Click the POINT tool on the Create 

Features window 

  Place a point in a new location in the 

display 

 Click the Attributes button on the 

Editor toolbar 

 Click inside the ID box and add a 

number  

  Press Enter 

  Close Attributes window 
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DIGITIZING LINES and SNAPPING 

 Navigate to neighborhood without digital roads   

 Add the SNAPPING toolbar to ArcMap. Click 

the Editor, slide to Snapping, click Snapping 

Toolbar 

 Confirm Snapping toolbar has END, Vertex, and 

Edge types active 

 Click the Snapping menu and click options. Set 

snap tolerance to at least 10 pixels 

 In the Create Features window, click Wake 

Roads line template and the Line tool 

 Rest pointer over existing road line but do not 

click. 

 Click once. 

 Using the aerial as a guide, digitize the new line 

by clicking the map each place you want to add a 

vertex 

 Press F2 key which finishes the sketch 

 Add Attributes for new line feature 

 

                                                                    

TO RESHAPE A LINE OR POLYGON FEATURE 

 To edit lines and vertices, turn on Snapping – Select Edit Vertices tool icon and 

add, delete and move vertices as needed. 

 Save Edits 

 Stop Editing 

 Turn off Editor toolbar 

 

 

15. Adding a Field to an Existing Layer 

 Open ArcCatalog and navigate to the layer or table you want to modify 

 Click the Contents tab in the ArcCatalog window 

 Click the layer you are adding the field to in the Catalog tree 

 Right-click the feature class in the Contents list and click properties 
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 Click the Fields tab. The columns in the feature 

class’s attribute table are listed. Check the field 

name, data, and data type for both the table and 

the geographic layer 

 Scroll to the bottom of the list of column 

names. Click in the 1
st
 empty row under Field 

Name of the last attribute and enter your new 

field 

 Click under the Data Type to the right of the 

new column’s name, click the drop down that 

appears, and click the appropriate data type 

 Click OK 
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16. How to Join a Table to a Geographic Layer 

There are two requirements to join a table to a geographic 

layer – the field must be the same data type and they both 

must have a field with the same values. 

 Right click on the layer you want to add the table 

to 

 Slide to Joins and Relates, then click on Joins 

 Make sure you select “Join attributes from a 

table” in the first box 

 For number 1, choose the field from the 

geographic layer the join will be based on 

 For number 2, choose the table you are joining to 

the geography 

 For number 3, choose the field from the table to 

join to the geographic layer 

 For this join you will want to Keep All Records, 

so click that button 

 

 

 

 

Steps: 

1. In the table of contents, right-click the layer or table you want to join, point to 

Joins and Relates, then click Join.  

You can also click the Table Options button on an open table window to access the 

Join Data dialog box. 

 

Tip: 

If you do not want your fields to be prefixed with the table name after a join, open the 

attribute table, click the Table Options menu, then uncheck Show Field Aliases. 

 

2. Click the What do you want to join to this layer? arrow and click Join 

attributes from a table.  

3. Click the field on which the join will be based.  

4. Choose the table to join to the layer or table. If it is not currently part of the map, 

click the browse button to search for it on disk.  

5. Click the field in that table on which the join will be based.  

6. Choose whether to keep all records or only matching records.  

7. Click OK.  
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Tip: 

If you want to permanently save joined data with your geographic features, export the 

data to a new feature class, right-click the layer in the table of contents, point to Data, 

then click Export data.  

Tip: 

When editing joined data, you cannot directly edit the joined columns. To edit the joined 

data, you must first add the joined tables or layers to ArcMap. You can then perform edits 

on this data separately. These changes are reflected in the joined columns. 

 

 

17. Georeferencing 
The link below explains georeferencing: 

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//009t000000mn000000  

 

The images below show the Georeferencing toolbar and functions. 

 

Button Name Function 

 

Rotate Rotates the source layer 

 

Shift Shifts the source layer 

 

Scale Rescales the source layer 

 

Add Control 

Points 

Allows you to select control points from a layer and add them to 

the map 

 

View Link Table Shows links and errors in tabular form 

 
 

 

 

 

 

 

 

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//009t000000mn000000
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 Click Customize tab, slide to Toolbars, and click beside Georeferencing. 

 

 

 

 

 Add image to georeference (fit to map) 

 Locate at least 4 points that both map and image have in common (similar roads 

or objects)  

 Add Control Points by clicking control point on image then toggling to map and 

clicking on same point. 

 Repeat for all control points 

 Click Georeferencing tool and select Update Display 

 Check Link Table for Residual Root Mean Square  

 Replace/correct Control Points to reduce RMS 

 

 

18. Creating a Map Book Using Data Driven Pages 

 

 Open the Search window 

 Type Map Book for search 

 

  

 Select Grid Index Features  

 The Output feature class is the object being mapped – this can be dragged and 

dropped from the Table of Contents 

  

  You can accept the 

defaults or make 

modifications to the 

Polygon Width & Height 

and Number of Rows 

options 

 

 Click OK to create grid 

    

 

 


